
Medida	de	raios	cósmicos	
	
Objetivos	
	
O	 objetivo	 deste	 experimento	 é	 de	medir	 partículas	 de	 chuveiros	 de	 raios	 cósmicos	 que	
chegam	no	nosso	laboratório	e,	a	partir	de	medidas	simples	de	diferença	de	tempo	entre	os	
sinais	de	dois	cintiladores	plásticos,	determinar	a	velocidade	média	destas	partículas.	
	
Leitura	recomendada	
	
Recomenda-se	a	leitura	e	estudo	dos	capítulos	8	e	9	do	Knoll,	que	tratam	sobre	cintiladores	
e	fotomultiplicadoras.	A	descrição	detalhada	do	processo	de	cintilação	e	conversão	da	luz	em	
sinal	 elétrico	 é	 um	 dos	 pontos	 a	 serem	 abordados	 pela	 equipe	 que	 for	 apresentar	 os	
resultados	deste	experimento	na	primeira	avaliação.	
	
Experimento	
	
O	experimento	consiste	em	dois	cintiladores	plásticos	orgânicos	de	20	x	20	cm2	e	1	cm	de	
espessura	 separados,	 verticalmente,	 de	 uma	 distância	 ajustável.	 A	 luz	 produzida	 nestes	
cintiladores	é	guiada	por	um	guia	de	luz	de	acrílico	de	tal	modo	que	um	se	assemelha	a	uma	
raquete	de	 tênis	 (cintilador	1)	e	o	outro,	 com	uma	TV	antiga	 (cintilador	2).	São	acopladas	
fotomultiplicadoras	 ao	 fim	 dos	 guias	 de	 luz	 para	 conversão	 do	 pulso	 luminoso	 em	 sinal	
elétrico.	Estas	 fotomultiplicadoras	 são	alimentadas	com	uma	tensão	de	aproximadamente	
2100	V.		
	
A	 ideia	 é	 medir	 a	 diferença	 de	 tempo	 entre	 o	 sinal	 produzido	 nos	 cintiladores	 1	 e	 2.	
Adotaremos	 o	 sinal	 do	 cintilador	 1	 como	 gatilho	 (trigger)	 de	 início	 da	medida	 de	 tempo	
(START)	e	o	sinal	do	cintilador	2	como	gatilho	de	final	de	medida	de	tempo	(STOP).	Para	medir	
o	intervalo	de	tempo	entre	os	dois	cintiladores	utilizaremos	um	módulo	TDC	(Time	to	Digital	
Converter).		
	
O	pulso	elétrico	produzido	é	então	processado	por	um	discriminador	de	 fração	constante	
(Constant	 Fraction	Discriminator,	 CFD)	 onde	 um	 sinal	 digital	 é	 produzido.	 Pode-se	 ajustar	
livremente	o	 limiar	 (threshold)	de	tensão	de	discriminação	de	modo	a	evitar	a	geração	de	
sinais	digitais	por	conta	de	ruído	no	detector.		No	caso	do	cintilador	2,	antes	de	o	sinal	ser	
processado	no	discriminador,	acrescenta-se	um	atraso	(cabos)	de	cerca	de	10	ns	para	evitar	
que	o	sinal	deste	cintilador	seja	processado	antes	do	primeiro	cintilador.	
	
Após	 a	 produção	 dos	 sinais	 digitais	 estes	 são	 enviados	 ao	módulo	 TDC.	O	 sinal	 digital	 do	
cintilador	1	é	conectado	como	START	e	o	do	cintilador	2,	como	STOP	no	canal	1	do	módulo	de	
TDC.		
	
A	aquisição	de	dados	é	realizada	por	um	computador	PC	com	Linux	que	se	comunica	com	o	
Crate	CAMAC	através	de	uma	interface	especial	e	um	controlador	CAMAC.	



	
Figura	1	–	Esquema	do	experimento.	

	
	
Um	esquema	completo	da	cadeia	eletrônica	é	mostrado	na	figura	1.	A	aquisição	de	dados	
ocorre	da	seguinte	maneira:	
	

1. O	usuário	configura	o	programa	de	aquisição	de	dados	(ver	adiante	a	receita)	e	inicia	
um	RUN	de	aquisição,	que	pode	ter	tempo	fixo	ou	não.	Quando	o	RUN	é	iniciado	o	
sistema	fica	esperando	a	geração	de	sinais	válidos	nos	módulos	conectados	no	Crate	
CAMAC.	

2. Quando	há	a	geração	de	um	sinal	de	START,	o	TDC	começa	o	processo	de	digitalização	
de	todos	os	seus	canais	(8	no	total).	

3. Se	 houver	 um	 sinal	 de	 STOP	 dentro	 do	 intervalo	 de	 digitalização,	 este	 sinal	 é	
convertido	em	um	número	de	11	bits	(0...2043)	e	armazenado	na	memória	do	TDC.	O	
módulo	TDC	gera,	na	BUS	do	Crate	CAMAC	um	aviso	que	chamamos	LAM	(Look	At	
Me),	informando	ao	controlador	do	CRATE	que	preste	atenção	porque	há	informação	
neste	módulo	

4. O	Controlador	do	CRATE,	neste	 caso,	 gera	uma	 interrupção	no	PC	de	aquisição	de	
dados.	As	interrupções	são	monitoradas	a	nível	do	kernel	do	Linux	e	disparam	rotinas	
de	processamento	no	programa	de	aquisição	de	dados,	chamado	SPMRoot.	Quando	
isto	ocorre,	o	SPMRoot	realiza	as	seguintes	ações:	

a. Executa	 uma	 rotina	 de	 aquisição	 e	 processamento	 de	 dados	 que	 pode	 ser	
livremente	programada	pelo	usuário.	Esta	rotina	é	escrita	em	uma	linguagem	
própria,	cujas	origens	estão	na	história	dos	sistemas	de	aquisição	de	dados	do	
Pelletron,	chamada	ADAC.	No	caso	deste	experimento,	esta	rotina	apenas	lê	o	
valor	armazenado	no	canal	1	do	TDC,	formata	o	dado	de	forma	apropriada	e	
armazena	no	computador.	Isto	é	denominado	EVENTO	

b. Em	seguida,	os	dados	do	EVENTO	armazenado	são	colocados	em	histogramas	
para	visualização	em	tempo	real	do	que	está	acontecendo	no	experimento.	
Como	 os	 histogramas	 são	 preenchidos	 e	 mostrados	 também	 pode	 ser	
livremente	programado	pelo	usuário	em	um	código	escrito	em	C++	utilizado	
bibliotecas	de	visualização	do	ROOT.	



5. Após	o	tempo	configurado	para	o	RUN	ou	quando	o	usuário	desejar,	o	RUN	é	parado.	
No	nosso	caso	específico,	o	programa	de	aquisição	grava	uma	tabela	de	dados	em	
arquivo	texto	(TDC.txt)	que	pode	ser	utilizado	para	fazer	gráficos	no	WebROOT,	por	
exemplo.	Este	arquivo	deve	ser	sempre	copiado	com	um	novo	nome.	

	
Montagem	do	experimento	
	
Os	módulos	de	processamento	já	estão	colocados	no	rack.	É	necessário,	contudo,	montar	a	
cadeia	 de	 sinal,	 calibrar	 o	 sistema,	 ligar	 as	 fotomultiplicadoras	 e	 realizar	 o	 experimento.	
Vamos	fazer	isto	passo	a	passo.	
	
Montagem	do	experimento	e	calibração	
	
Para	 montagem	 do	 experimento	 e	 calibração	 vamos	 substituir	 os	 cintiladores	 por	 um	
pulsador.	 Isto	é	útil	pois	podemos	simular	os	sinais	dos	cintiladores	de	forma	sincronizada	
para	poder	fazer	a	calibração	em	tempo	do	TDC.	Para	isto	vamos	montar	o	arranjo	da	figura	
2.	
	

	
Figura	2	–	Montagem	inicial	para	calibração.	

	
Siga	os	seguintes	passos.	Não	se	esqueça	de	anotar	o	que	está	fazendo	

1. Ligue	o	pulsador	e	olhe	no	osciloscópio	o	sinal	gerado.	O	sinal	deve	ser	negativo,	com	
amplitude	de	aproximadamente	-1	V.	Regule	o	sinal	se	for	o	caso.		

2. Divida	o	 sinal	em	duas	cadeias.	 Isto	pode	ser	 feito	 simplesmente	com	um	Y	e	dois	
cabos.	Tome	cuidado	com	os	tamanhos	dos	cabos.	Eles	devem	ser	os	mesmos	cabos	
que	 serão	 ligados	 nas	 fotomultiplicadoras.	 Cabos	 de	 16	 ns	 chegam	 nas	
fotomultiplicadoras	sem	problema.	

3. Um	dos	sinais	simula	o	cintilador	2.	Este	deve	ser	atrasado	de	um	valor	que	podemos	
regular	em	ns.	Para	fazer	o	atraso,	vamos	usar	cabos	coaxiais	enrolados.	Cada	rolo	tem	
um	atraso	de	aproximadamente	10	ns.	Para	atrasos	menores	podemos	utilizar	cabos	
menores.	Comece	com	um	atraso	de	10	ns.		

4. Ligue	o	cabo	que	simula	o	cintilador	1	no	CFD.	Use	o	osciloscópio	para	monitorar	o	
sinal	 de	 saída	 digital.	 Usando	 um	 voltímetro,	 ajuste	 um	 threshold	 de	



aproximadamente	-400	mV	no	discriminador	1.	Verifique	se	há	sinais	espúrios	sendo	
gerados.	Se	houver	muitos	sinais	espúrios,	aumente	o	threshold.	

5. Faça	 o	 mesmo	 para	 o	 cintilador	 2.	 No	 discriminador	 2,	 use	 um	 threshold	 de	
aproximadamente	-250	mV.	Isto	aumenta	um	pouco	o	nível	de	coincidências	entre	os	
dois	sinais	dos	discriminadores.	

6. Ligue	o	sinal	digital	do	discriminador	1	 (saída	B)	como	START	no	TDC.	Ligue	o	sinal	
digital	do	discriminador	2	(saída	B)	como	STOP	no	TDC.	Ligue	também	estes	sinais	no	
osciloscópio	para	monitorar	o	experimento.	

7. Inicie	o	programa	de	aquisição	de	dados.	No	computador:	
a. Abra	uma	janela	de	terminal	
b. Mude	para	o	diretório	cosmicos2016	digitando	

i. cd	~/cosmicos2016	
c. Inicie	o	programa	de	aquisição	de	dados	digitando	

i. spmroot	&		
d. Carregue	os	programas	necessários	para	configurar	a	aquisição	de	dados	

i. File	->	Load	EVO	
ii. Escolha	o	arquivo	aquis.evo	

e. Para	carregar	o	programa	de	geração	de	histogramas:	
i. File	->	Load	Histogram	definitions	
ii. Escolha	o	arquivo	histograms.so	

f. Para	ver	o	histograma	de	dados,	faça:	
i. Display	->	new	TBrowser	
ii. Clique	em	SPM_Histograms	no	Browser	que	aparece	
iii. Dê	um	clique	duplo	em	TDC	

	
Vamos	agora	começar	o	processo	de	calibração.	Para	isto,	monitore	os	sinais	digitais	dos	dois	
discriminadores	no	osciloscópio,	conforme	mostrado	na	figura	2.	Você	verá	o	sinal	digital	do	
segundo	discriminador	deslocado	em	relação	ao	primeiro	discriminador.	Este	deslocamento	
deve	ser	próximo	ao	atraso	utilizado	na	montagem.	Meça	este	atraso	com	o	osciloscópio	e	
anote	este	valor.		
	
Devemos	tomar	dados	para	várias	configurações	de	atraso	extra.	Este	atraso	extra	simula	a	
diferença	 de	 tempo	 devido	 à	 distância	 entre	 os	 dois	 cintiladores.	 Faça	 tomada	 de	 dados	
variando	o	atraso	desde	10	ns	até	cerca	de	100	ns,	de	10	em	10	ns.	Para	cada	atraso,	meça	a	
diferença	de	tempo	entre	os	sinais	digitais	no	osciloscópio	e	adquira	o	histograma	para	a	cada	
um	deles.	
	
A	calibração	consiste	em	fazer	um	gráfico	da	posição	do	pico	no	histograma	em	função	do	
atraso	medido	no	osciloscópio.	Depois	ajusta-se	uma	função	a	este	gráfico	(uma	reta	deve	ser	
suficiente,	mas	avalie	 isto)	e	esta	curva	é	utilizada	mais	tarde	para	definir	o	valor	real	das	
medidas	de	tempo	realizadas.	
	
Para	fazer	uma	tomada	de	dados	com	o	sistema	de	aquisição,	siga	o	seguinte	procedimento:	

1. Regule	o	atraso	que	se	quer	medir	
2. Limpe	o	conteúdo	do	histograma	

a. Tools	->	Zero	ALL	histograms	
b. Responda	YES	



3. Inicie	um	RUN	 (no	 caso	da	 calibração,	 cerca	de	1	minuto	de	 aquisição	de	dados	é	
suficiente)		

a. Pressione	o	botão	RUN	
b. Será	perguntado	o	número	do	RUN	(muda	automaticamente)	e	o	tempo	de	

aquisição	 em	 segundos.	 Para	 a	 calibração,	 cerca	 de	 30	 segundos	 são	
suficientes.	

4. No	final	de	cada	RUN,	um	arquivo	chamado	TDC.txt	é	criado	com	três	colunas:	canal	
do	TDC,	número	de	contagens	e	incerteza	no	número	de	contagens.	Renomeie	este	
arquivo	para	poder	identificar	cada	histograma	de	calibração.	

5. Repita	este	procedimento	para	os	demais	atrasos	
	
Ao	final	do	processo	o	sistema	está	devidamente	calibrado.		
	

1. Coloque	um	atraso	de	cerca	de	50	ns	no	sinal	do	cintilador	2.		
2. Faça	um	run	com	o	pulsador	para	determinar	a	sua	referência	Dt	=	0	
3. Ligue	os	cabos	nas	fotomultiplicadoras	correspondentes,	como	na	figura	1,	e	você	está	

pronto	 para	 realizar	 as	 medidas.	 Você	 pode	 deixar	 o	 osciloscópio	 montado	 para	
sempre	monitorar	os	sinais.	

	
Realizando	as	medidas	
	
As	fotomultiplicadoras	já	devem	estar	com	alta	tensão.	Se	não	estiverem	(não	vai	ter	sinal),	
converse	com	um	professor.	
	
Inicie	as	medidas	com	os	dois	cintiladores	bem	próximos.	Dá	para	regular	a	altura	entre	eles.	
Meça	esta	altura.	Faça	a	tomada	de	dados	para	esta	altura	e	salve	os	dados	do	histograma.	
Não	esqueça	de	zerar	os	histogramas	entre	medidas	para	não	superpor	dados	com	distâncias	
diferentes.	
	
Varie	a	distância	entre	os	cintiladores	até	o	máximo	possível.	Umas	5-6	distâncias	diferentes	
são	suficientes.	
	
Para	distâncias	pequenas,	perto	de	uma	hora	de	tomada	de	dados	deve	ser	suficiente	para	
uma	boa	estatística	no	histograma.	Para	distâncias	maiores,	talvez	sejam	necessárias	várias	
horas	de	tomada	de	dados.	Neste	caso,	combine	com	alguém	do	grupo	para	 ir	de	vez	em	
quando	no	 laboratório	monitorar	o	experimento	e	parar/começar	uma	nova	medida.	Não	
esqueça	de	anotar	quanto	tempo	cada	tomada	de	dados	levou.	E	não	esqueça	de	renomear	
o	arquivo	TDC.txt	com	os	dados	tomados	em	cada	medida.	
	
Análise	dos	dados	
	
Para	 cada	 histograma	 dos	 dados	 tomados,	 ajuste	 o	 espectro	 de	 tempo	 obtido	 com	 uma	
função	apropriada	e	extraia	a	posição	do	pico	com	sua	incerteza.	Em	geral	é	necessário	usar	
duas	gaussianas,	porque	podemos	ter	partículas	que	incidem	de	cima	para	baixo,	passando	
primeiro	pelo	cintilador	1	(os	chuveiros	de	raios	cósmicos)	e	podemos	ter	partículas	 (mais	
raro)	de	baixo	para	cima,	passando	primeiro	pelo	cintilador	2.	Isto	fica	mais	evidente	quando	



os	 cintiladores	 estão	 bem	 distantes,	 pois	 dá	 para	 perceber	 a	 existência	 de	 dois	 picos	 no	
espectro	de	tempo.	
	
Com	base	nisto,	usando	a	 calibração	em	 tempo,	 faça	um	gráfico	de	 tempo	em	 função	da	
distância.	Avalie	este	gráfico.	É	uma	reta?	Obtenha	a	velocidade	média	das	partículas	medidas	
a	partir	deste	gráfico.	Qual	é	o	valor,	em	comparação	com	a	velocidade	da	luz.	Isto	é	razoável?	
Discuta.	
	
Faça	também	um	gráfico	da	taxa	de	partículas	medidas	(número	de	partículas	por	segundo)	
em	função	da	distância	entre	os	dois	cintiladores.	O	que	você	espera	obter	deste	gráfico?	O	
comportamento	medido	está	dentro	do	esperado?	Discuta.	
	
Para	a	apresentação	
	
O	grupo	que	for	apresentar	os	resultados	deste	experimento	como	primeira	avaliação	deve	
focar	na	apresentação	os	seguintes	aspectos	
	

1. Interação	da	radiação	com	a	matéria,	principalmente	múons	
2. Princípios	de	funcionamento	de	cintiladores	e	fotomultiplicadoras	
3. Processamento	de	dados	digitais	
4. Aquisição	de	dados	
5. Calibração	do	da	medida	em	tempo.	Discutir	a	linearidade	da	calibração	realizada.	
6. Medidas	efetuadas	e	resultados	obtidos	
7. Discutir	se	as	taxas	de	contagem	observadas	são	compatíveis	com	o	esperado	para	

raios	cósmicos	
8. Discutir	a	observação	ou	não	de	partículas	vindo	de	baixo	para	cima.	

	
Todas	as	discussões	devem	ser	baseadas	nos	dados	e	análise	dos	mesmos.	Deve-se	ter	o	rigor	
estatístico	e	tratamento	de	erros	apropriado.	


